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Windows/Linux Mac equivalent Effect

Menuselectie Extra > 
Opties 

LibreOffice > Voorkeuren Toegang tot instellingsopties

Rechtsklik Control+klik Contextmenu openen

Ctrl (Control) z (Command) Gebruikt met andere toetsen

F5 Shift+z+F5 De Navigator openen

F11 z+T Het venster Stijlen en opmaak openen
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Wat is Draw?

Draw is een tekenprogramma voor vectorafbeeldingen, hoewel het ook enkele bewerkingen op 
rasterafbeeldingen (pixels) kan uitvoeren. Door Draw te gebruiken kunt u snel een groot scala aan 
grafische afbeeldingen maken.

Vectorafbeeldingen worden opgeslagen en geven een afbeelding weer als eenvoudige 
geometrische elementen zoals lijnen, cirkels, en veelhoeken in plaats van als een verzameling 
pixels (punten op het scherm). Vectorafbeeldingen maken eenvoudige opslag en weergeven op 
een andere schaal mogelijk.

Draw is volledig geïntegreerd in het kantoorpakket LibreOffice, en dit vereenvoudigt het uitwisselen 
van afbeeldingen tussen alle componenten van het pakket. Als u bijvoorbeeld een afbeelding 
maakt in Draw, is het opnieuw gebruiken daarvan in een Writerdocument net zo eenvoudig als het 
kopiëren en plakken van die afbeelding. U kunt ook rechtstreeks met afbeeldingen werken in 
Writer en Impress, waarbij u een deel van de functies en gereedschappen van Draw kunt 
gebruiken.

De functionaliteit van Draw is uitgebreid; hoewel het niet werd ontworpen om de concurrentie aan 
te gaan met andere uitmuntende grafische toepassingen, bezit Draw toch meer functies dan de 
meeste tekenprogramma's die geïntegreerd zijn in kantoorpakketten.

Een paar voorbeelden van tekenfuncties zijn:

• Lagenbeheer

• Magnetisch systeem van rasterpunten

• Weergave van dimensies en maateenheden

• Verbindingen voor het maken van organogrammen

• 3D-functies die het mogelijk maken kleine driedimensionale tekeningen te maken (met 
textuur- en belichtingseffecten)

• Integratie van tekening- en paginaopmaakprofielen

• Bézier-bogen

Dit hoofdstuk introduceert een aantal functies van Draw, maar niet alle functies worden besproken. 
We verwijzen hiervoor naar de Handleiding voor Draw en de Help-functie voor meer informatie.

De werkruimte van Draw

De belangrijkste componenten van de werkruimte van Draw ziet u in Afbeelding 1.

U kunt rondom het tekengebied werkbalken en informatie-gebieden plaatsen. Het aantal en de 
positie van de zichtbare gereedschappen variëren met de uit te voeren taak en de voorkeuren van 
de gebruiker. Daarom kan uw configuratie er anders uitzien. Voorbeeld: veel mensen zetten de 
belangrijkste werkbalk Tekening aan de linkerkant van de werkruimte, niet onderaan, zoals hier 
wordt getoond.

U kunt de tekeningen in Draw splitsten over meerdere pagina's. Tekeningen over meer pagina's 
worden voornamelijk gebruikt voor presentaties. Het deelvenster Pagina's, aan de linkerkant van 
het venster van Draw in Afbeelding 1 geeft een overzicht van de pagina's die u maakt. Als het 
deelvenster Pagina's niet zichtbaar is op uw weergave, kunt u het vanuit het menu Beeld (Beeld > 
Deelvenster Pagina) oproepen.
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Afbeelding 1. Beginvenster van Draw

Linialen
U ziet linialen (balken met nummers) aan de 
boven- en linkerkant van de werkruimte. De linialen 
geven de grootte van een geselecteerd object op 
de pagina weer (zie de grijze dubbele lijnen, zoals 
geaccentueerd in Afbeelding 2). Wanneer geen 
object is geselecteerd, tonen ze de locatie van de 
muisaanwijzer, dit helpt bij het meer nauwkeurig 
plaatsen van de tekenobjecten.

U kunt de linialen ook gebruiken om object-
handvatten en hulplijnen te beheren, waardoor 
het gemakkelijker wordt om objecten te 
plaatsen. De pagina-marges in het tekengebied 
worden ook weergegeven op de linialen. U kunt 
de marges rechtstreeks op de linialen wijzigen 
door deze te verslepen met de muis.

Klik met rechts op één van de linialen en 
selecteer één van de maateenheden om de 
maateenheid van de linialen te wijzigen. De 
twee linialen kunnen verschillende eenheden 
hebben. 
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het geselecteerde object weer

Afbeelding 3. Eenheden van de linialen



Statusbalk
De statusbalk bevindt zich aan de onderzijde van het scherm (in alle componenten 
van LibreOffice); het bevat verscheidene velden specifiek voor Draw.

Bekijk hoofdstuk 1 Kennismaken met LibreOffice van Handleiding voor beginners en hoofdstuk 1 
Kennismaken met Draw in de Handleiding voor Draw, voor details over de inhoud en het gebruik 
van deze velden.

Opmerking

De groottes worden gegeven in de huidige maateenheid (niet te verwarren met de 
eenheden op de linialen). Deze eenheid wordt gedefinieerd in Extra > Opties > 
LibreOffice Draw > Algemeen, waar u ook de schaal van de pagina kunt wijzigen. 
Een andere manier om de schaal te wijzigen is door dubbel te klikken op het getal 
weergegeven in de statusbalk.

Afbeelding 4: Linker uiteinde van de statusbalk in Draw

Afbeelding 5: Rechter uiteinde van de statusbalk van Draw

Werkbalken
De verschillende werkbalken van Draw weergeven en verbergen. 

Kies Beeld > Werkbalken. U kunt, uit het menu dat verschijnt, kiezen welke werkbalken u wilt 
tonen. Voor meer over het werken met werkbalken, zie hoofdstuk 1 Kennismaken met LibreOffice 
in dit boek.

De gereedschappen die beschikbaar zijn op de werkbalken van Draw worden in de volgende 
gedeelten nader uitgelegd. Het uiterlijk van de pictogrammen op de werkbalken kan variëren, 
afhankelijk van uw besturingssysteem en de keuze van de grootte en stijl van de pictogrammen in 
Extra > Opties > LibreOffice > Weergave.

Werkbalk Standaard

De werkbalk Standaard is dezelfde voor alle componenten van LibreOffice en wordt in dit 
hoofdstuk niet beschreven.
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Werkbalk Lijn en opvulstijl
De werkbalk Lijn en opvulstijl, stelt u in staat om de belangrijkste eigenschappen van een 
tekenobject te wijzigen. Zie pagina 24 voor details.

Werkbalk Tekstopmaak
Als het geselecteerde object tekst bevat, verandert de werkbalk naar de werkbalk Tekstopmaak, 
die vergelijkbaar is met de werkbalk Opmaak in Writer. Voor meer informatie, zie hoofdstuk 4 
Kennismaken met Writer.

Werkbalk Tekening
De werkbalk Tekening is de belangrijkste werkbalk in Draw. Hij bevat alle nodige functies voor het 
tekenen van verschillende geometrische en vrije hand-vormen en ook om ze te schikken op de 
pagina.

Werkbalk Opties
Met de werkbalk Opties kunt u verschillende vormen van hulp bij het tekenen in- of uitschakelen. 
Selecteer Beeld > Werkbalken > Opties om de werkbalk Opties weer te geven.

Kleuren kiezen en definiëren

De Kleurenbalk
Gebruik Beeld > Werkbalken > Kleurenbalk om de Kleurenbalk weer te geven. De werkbalk 
verschijnt dan onderaan de werkruimte.

Deze werkbalk stelt u in staat om snel een kleur toe te kennen aan de objecten in uw tekening. Het 
eerste vak in het paneel komt overeen met transparant (geen kleur).

U hebt toegang tot verschillende gespecialiseerde kleurenpaletten in Draw, en ook de mogelijkheid 
om individuele kleuren naar uw eigen smaak te definiëren. Dit kan door te kiezen Opmaak > Vlak, 
of het pictogram Vlak op de werkbalk Lijn en opvulstijl. Dit opent het dialoogvenster Gebied. Kies 
de tab Kleuren.
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Klik op de knop Kleurenlijst laden (omcirkeld) om een ander palet te laden. In het dialoogvenster 
voor bestandsselectie wordt u gevraagd om te kiezen uit één van de standaard paletten van 
LibreOffice (bestanden met de extensie *.soc). Bijvoorbeeld, web.soc is een kleurenpalet dat 
speciaal is aangepast voor het maken van tekeningen in webpagina's. De kleuren worden correct 
weergegeven op werkstations met schermen van ten minste 256 kleuren.

Het keuzevak voor de kleuren laat u elke kleur afzonderlijk wijzigen door de numerieke waarden 
aan te passen in de velden aan de rechterkant van het kleurenpalet. U kunt de kleurenschema's 
bekend als CMYK (cyaan, magenta, geel, zwart) en RGB (rood, groen, blauw) gebruiken.

Afbeelding 6. Het kleurenpalet wijzigen

Klik op de knop Bewerken om het dialoogvenster Kleur te openen, waar u de individuele kleuren 
kunt instellen. Zie 'Kleuropties' in hoofdstuk 2 LibreOffice instellen van dit boek. Veel meer 
mogelijkheden voor invoer zijn beschikbaar in dit dialoogvenster.

Voor een meer gedetailleerde beschrijving van kleurenpaletten en hun opties, zie hoofdstuk 8 Tips 
en Trucs in de Handleiding voor Draw.

Objecten positioneren met functies “Vangen aan”

In Draw kunnen objecten accuraat en consistent geplaatst worden met behulp van rasterpunten, 
speciale vangpunten en -lijnen, objectframes, individuele punten op objecten, of paginaranden. 
Deze functie staat bekend als Vangen aan.

Met de functie Vangen aan is gemakkelijker te werken met de praktisch hoogst mogelijke waarde 
voor inzoomen. U kunt twee verschillende functies voor vangen aan tegelijkertijd gebruiken, 
bijvoorbeeld vangen aan een hulplijn en aan de paginarand. Het is het beste om alleen die 
functies, die u echt nodig hebt, te activeren.

Dit gedeelte beschrijft de functie Vangen aan raster. Voor meer gedetailleerde informatie over de 
functies Vangen aan, bekijk hoofdstuk 8 Tips en trucs en hoofdstuk 10 Geavanceerde technieken 
voor Draw in de Handleiding voor Draw.
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Vangen aan raster
Gebruik deze functie om een object precies naar een rasterpunt te verplaatsen (zie Afbeelding 7). 
De functie kan in- en uitgeschakeld worden met Beeld > Raster > Vangen aan raster en via de 
werkbalk Opties met het pictogram . 

Afbeelding 7: Exacte plaatsing met Vangen aan raster

Raster tonen
Kies Beeld > Raster > Raster tonen om het raster zichtbaar te maken. U kunt, als alternatief, het 
raster ook in- (en uitschakelen) met het pictogram  op de werkbalk Opties.

Het raster instellen
De kleur, afstand, en de resolutie van de rasterpunten kunnen individueel gekozen worden voor 
elke as. De afstand tussen de lijnen is vastgelegd in de opties van het dialoogvenster Raster 
(Extra > Opties > LibreOffice Draw > Raster).

Afbeelding 8: Opties voor raster instellen

In het dialoogvenster dat is weergegeven in Afbeelding 8, kunt u de volgende parameters instellen:
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• Verticale en horizontale afstand tussen de punten in het raster. U kunt ook de 
maateenheid, gebruikt in de algemene opties voor Draw, instellen (Extra > Opties > 
LibreOffice Draw > Algemeen).

• De resolutie is de grootte van de vierkanten of rechthoeken in het raster. Als de resolutie 1 
cm Horizontaal en 2 cm Verticaal is, bestaat het raster uit rechthoeken van 2 cm hoog en 1 
cm breed.

• Onderverdelingen zijn extra punten die verschijnen aan de zijkanten van elke rechthoek of 
vierkant in het raster. Objecten kunnen gevangen worden aan onderverdelingen en ook 
aan de hoeken van het raster.

• De pixelgrootte (pix element) van het vanggebied bepaalt hoe dicht u het object bij een 
vangpunt of -lijn moet slepen alvorens het daaraan gevangen wordt.

De kleur van de rasterpunten veranderen
De standaard rasterpunten zijn lichtgrijs en kunnen soms moeilijk te zien zijn. Kies Extra > Opties 
> LibreOffice > Vormgeving om de kleur van de rasterpunten te wijzigen.

Afbeelding 9: Wijzigen van de kleur van het raster

In de sectie Tekening / Presentatie kunt u de kleur van de rasterpunten wijzigen. Selecteer een 
meer geschikte/zichtbare kleur, bijvoorbeeld zwart, in de keuzelijst Kleurinstelling.

Objecten positioneren met hulplijnen

Ter vereenvoudiging van het plaatsen van objecten is het mogelijk hulplijnen zichtbaar te maken—
uitbreidingen van de randen van het object—terwijl het object wordt verplaatst. Deze hulplijnen 
hebben geen vangfunctie. 

De hulplijnen kunnen worden in- of uitgeschakeld met Extra > Opties > LibreOffice Draw > 
Weergave > Hulplijnen bij verplaatsen, of door te klikken op het pictogram  op de werkbalk 

Opties.
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De basis tekenvormen

Draw verschaft een grote hoeveelheid van vormen, geplaatst op paletten die toegankelijk zijn via 
de werkbalk Tekening. Deze alinea beschrijft slechts een aantal van deze basisvormen. Deze 
vormen omvatten rechthoeken en vierkanten, cirkels, ellipsen en bogen, 3D-objecten, krommen, 
lijnen en pijlen, tekst en verbindingen. Alle vormen in Draw worden 'objecten' genoemd. Bekijk de 
Handleiding voor Draw voor een complete beschrijving van de beschikbare vormen. 

Opmerking
Wanneer u een basisvorm tekent of er één selecteert om te bewerken, zal het veld 
Info in de statusbalk wijzigen om de uitgevoerde actie te reflecteren: Maken lijn, 
Tekstframe xxyy geselecteerd, enzovoort. 

Afbeelding 10 toont een deel van de werkbalk Tekening met de knoppen die nodig zijn in de 
volgende secties. Het pictogram Tekst is ook opgenomen.

Afbeelding 10: Gedeelte van de werkbalk Tekening

Een rechte lijn tekenen

Klik op het pictogram Lijn  op de werkbalk Tekening en plaats de muisaanwijzer daar waar u 
wilt dat de lijn begint. Sleep de muisaanwijzer met de linkermuisknop ingedrukt. Laat de muisknop 
los op het punt waar u wilt dat de lijn moet eindigen. 

Een handvat voor selectie verschijnt aan elk uiteinde van de lijn, wat aangeeft dat dit het huidige 
geselecteerde object is.

Afbeelding 11: Een rechte lijn tekenen

Houd de Shift-toets ingedrukt terwijl u de lijn tekent om de hoek van de lijn tot een veelvoud van 45 
graden (0, 45, 90, 135 enzovoort) te begrenzen.

Houd de Ctrl-toets ingedrukt tijdens het tekenen van de lijn om het einde van de lijn aan het 
dichtstbijzijnde rasterpunt te laten vangen.

Opmerking

Het effect van de Alt-toets is afhankelijk van de instellingen van de optie Vangen 
aan raster in het menu Beeld > Raster > Vangen aan raster:
Vangen aan raster aan: Alt schakelt de optie vangen aan  uit, zolang u de toets 
ingedrukt houdt.
Vangen aan raster uit: Alt schakelt de optie vangen aan  in, zolang u de toets 
ingedrukt houdt.
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Houd de Alt-toets ingedrukt tijdens het tekenen van de lijn om de lijn symmetrisch in beide 
richtingen uit te breiden vanaf het beginpunt (deze functionaliteit is niet beschikbaar in Linux).

Selecteer de lijn door er op te klikken en gebruik dan de gereedschappen op de werkbalk Lijn en 
opvulstijl om lijnattributen (bijvoorbeeld de kleur of het lijntype) te wijzigen; of voor meer controle: 
klik met rechts op de lijn en kies Lijn om het dialoogvenster Lijn te openen.

Een pijl tekenen
Pijlen worden getekend zoals lijnen. Draw classificeert pijlen als een subgroep van lijnen: Lijnen 
met pijlpunten. Ze worden in het veld Informatie op de statusbalk slechts als lijnen weergegeven. 
Klik op het pictogram Lijn met pijluiteinde  om een pijl te tekenen.

Lijnuiteinden kiezen
Verschillende soorten lijnuiteinden (pijlen, cirkels, vierkanten en andere) zijn beschikbaar in Draw. 
Kies Beeld > Werkbalken > Pijlen, of klik op het kleine zwarte driehoekje naast het pictogram 
Lijnen en pijlen om een pijl te tekenen. 

1 Lijn 5 Lijn (45°) 8 Lijn met vierkant/pijl

2 Lijn begint met pijl 6 Lijn eindigt met pijl 9 Maatlijn

3 Lijn met pijl/cirkel 7 Lijn met cirkel/pijl 10 Lijn met 2 pijlen

4 Lijn met pijl/vierkant

Een rechthoek of vierkant tekenen
Rechthoeken tekenen gaat op dezelfde wijze als het tekenen van een rechte lijn, behalve dat u nu 

het pictogram Rechthoek  gebruikt van de werkbalk Tekening, en de (denkbeeldige) met de 

muis getekende lijn overeenkomt met een diagonaal van de rechthoek. De rechthoek wijzigt van 
vorm als u de muis versleept.

Afbeelding 12: Een rechthoek tekenen

Houd de Shift-toets ingedrukt om een vierkant te tekenen. Houd de Alt-toets ingedrukt om een 
rechthoek vanuit zijn middelpunt te tekenen. Houd de Shift- en Alt-toets tegelijkertijd ingedrukt om 
de effecten te combineren. (ook hier werkt de Alt-toets in Linux niet zoals beschreven)
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Een cirkel of een ellips tekenen

Gebruik het pictogram Ellips  op de werkbalk Tekening om een ellips (ook wel een ovaal 
genoemd) of een cirkel te tekenen. (Een cirkel is eenvoudigweg een ellips waarvan de twee assen 
dezelfde lengte hebben.) De getekende ellips is de grootste ellips die zou passen in de 
(denkbeeldige) rechthoek, waarvan de diagonaal getekend wordt met de muis.

Afbeelding 13: Een ellips tekenen

Hier zijn enkele andere manieren om een ellips of cirkel te tekenen:

• Houd de Shift-toets ingedrukt tijdens het slepen met de muis om een cirkel te tekenen.

• Houd de Alt-toets ingedrukt tijdens het slepen met de muis om een ellips te tekenen met 
het beginpunt in het middelpunt (in plaats van vanuit de hoek).

• Houd zowel de Alt als de Shift-toets ingedrukt tijdens het slepen met de muis om een cirkel 
te tekenen met het beginpunt in het middelpunt. (ook hier werkt de Alt-toets in Linux niet 
zoals beschreven)

• Houd de Ctrl-toets ingedrukt tijdens het slepen met de muis om een ellips of cirkel te 
tekenen die wordt gevangen aan de dichtstbijzijnde rasterpunten.

Opmerking

Als u eerst de Ctrl-toets indrukt en vasthoudt en dan op één van de pictogrammen 
voor Lijn, Rechthoek, Ellips of Tekst klikt, dan wordt het gekozen object automatisch 
in de werkruimte getekend; de grootte, vorm en kleur zijn standaard waarden. Deze 
attributen kunnen later gewijzigd worden, indien gewenst.

Bogen tekenen
De gereedschappen voor het tekenen van bogen of veelhoeken staan op de werkbalk, die 
verschijnt als u klikt op de pijl naast het pictogram Boog op de werkbalk Tekening. Deze werkbalk 
bevat acht gereedschappen (Afbeelding 14).

Als u de muiscursor boven één van de pictogrammen beweegt, verschijnt een helptip met 
de beschrijving van de functie.

Opmerking
De muiscursor over dit pictogram bewegen geeft een helptip voor Boog. Als u het 
pictogram converteert naar een zwevende werkbalk, wordt de titel Lijnen zichtbaar, 
zoals weergegeven in Afbeelding 14.
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Veelhoeken
Teken de eerste lijn vanuit het beginpunt met de linker muisknop ingedrukt. Zodra u de 
muisknop loslaat, wordt een eerste hoekpunt getekend; verplaats de muis om te zien hoe de 
tweede lijn er uit zal zien. Elke muisklik stelt een ander hoekpunt in. Een dubbelklik beëindigt 
het tekenen. Een gevulde veelhoek verbindt automatisch het laatste punt met het eerste punt 
om de figuur af te sluiten en vult het met de huidige standaard opvulkleur. Een veelhoek zonder 
vulling zal niet worden gesloten aan het einde van de tekening.

Veelhoek 45°
Net als bij gewone veelhoeken worden deze gevormd door lijnen, maar met hoeken van 45 of 
90 graden ertussen.

Vrije-handlijn
Met dit gereedschap kunt u tekenen net zoals met een potlood. Houd de linkermuisknop 
ingedrukt en sleep de muis. Het is niet nodig om het tekenen met een dubbele klik te 
beëindigen. Gewoon de muisknop loslaten en het tekenen is voltooid. Als u Vrije-handlijn, 
gevuld hebt geselecteerd, wordt het eindpunt automatisch met het beginpunt verbonden en 
wordt het object gevuld met de toepasselijke kleur.

Bogen en gevulde bogen
Voor een meer uitgebreide beschrijving van de behandeling van bogen en gevulde bogen, zie 
hoofdstuk 10 Geavanceerde technieken voor Draw in de Handleiding voor Draw.

Tekst schrijven

Gebruik het gereedschap Tekst  om tekst te schrijven en selecteer het lettertype, kleur, grootte 
en andere attributen. Klik op de locatie waar u de tekst wilt plaatsen of klik en sleep om een groter 
tekstframe te maken. Druk op Enter om de cursor naar de volgende regel te verplaatsen.

Als u klaar bent met het typen van tekst, klik dan buiten het tekstframe. U kunt altijd op de tekst 
dubbelklikken om die te wijzigen.

Als u het gereedschap Tekst gebruikt wordt de werkbalk Tekstopmaak zichtbaar; die bevat de 
gewone attributen voor alinea's: inspringingen, eerste regel en tabstops.

De basis tekenvormen 17

1 Boog, gevuld 4 Veelhoek 7 Vrije-handlijn, gevuld

2 Boog 5 Veelhoek (45°), gevuld 8 Vrije-handlijn

3 Veelhoek, gevuld 6 Veelhoek (45°)

Afbeelding 14: Werkbalk Bogen (onjuist getiteld “Lijnen”)



U kunt opmaakprofielen voor afbeeldingen maken die u opnieuw kunt gebruiken voor andere 
tekstframes. Selecteer Opmaak > Stijlen en opmaak of druk op F11 om het venster Stijlen en 
opmaak te openen. Opmaakprofielen voor afbeeldingen zijn van invloed op alle tekst in een 
tekstframe. Gebruik directe opmaak met de werkbalk om delen van de tekst op te maken.

Tekstframes kunnen ook gevuld worden met kleuren, schaduwen, en andere attributen, net als alle 
andere Draw-objecten. U kunt het frame draaien en tekst schrijven onder elke hoek. Deze opties 
worden beschikbaar door met de rechtermuisknop te klikken op het object.

Gebruik het gereedschap Toelichtingen, geplaatst op de werkbalk Tekening, om toelichtingen te 
maken (ook wel ballonnen of afbeeldingslabels genoemd).

Als u dubbelklikt op een object of drukt op F2 (of op het pictogram Tekst op de werkbalk Tekening) 
als een object is geselecteerd, wordt de tekst geschreven in het midden van het object en blijft 
binnen de grenzen het object. Bijna elk soort object bevat zulk een extra tekstelement. Deze 
teksten hebben kleine verschillen met die in de tekstframes met betrekking tot positie en 
woordafbreking.

Voor meer over tekst, zie hoofdstuk 2 Basisvormen tekenen en hoofdstuk 10 Geavanceerde 
technieken voor Draw in de Handleiding voor Draw.

Plakpunten en verbindingen
Alle Draw-objecten hebben gekoppelde onzichtbare plakpunten, die zichtbaar worden als u één 

van de verbindingen kiest onder het pictogram Verbinding op  de werkbalk Tekening en dan 
de muisaanwijzer over het object beweegt. De meeste objecten hebben vier plakpunten, zoals 
weergegeven in Afbeelding 15. U kunt meer plakpunten toevoegen en plakpunten aanpassen, met 
behulp van de werkbalk onder het pictogram Plakpunten   op de werkbalk Tekening.

Afbeelding 15: Vier plakpunten

Plakpunten verschillen van handgrepen (de kleine blauwe of groene vierkantjes rondom een 
object). De handvatten zijn voor het verplaatsen of wijzigen van de grootte van een object. De 
plakpunten verbinden verbindingen aan een object.

Verbindingen zijn lijnen of pijlen waarvan het einde zich automatisch vast zet aan de plakpunten 
van een object. Wanneer u het andere object verplaatst, beweegt de verbinding mee. Verbindingen 
zijn vooral nuttig voor het maken van organogrammen. U kunt de blokken van uw diagram 
reorganiseren en alle verbonden objecten blijven verbonden.

Afbeelding 16 geeft twee Draw-objecten en een verbinding weer.
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Afbeelding 16: Een verbinding tussen twee objecten

Draw biedt een scala aan verschillende verbindingen en functies voor verbindingen. Open de 
zwevende werkbalk Verbinding door te klikken op de pijl naast het pictogram Verbinding. Voor 
meer informatie over verbindingen en plakpunten, zie hoofdstuk 9 Organogrammen, 
stroomdiagrammen en meer in de Handleiding voor Draw.

Geometrische vormen tekenen

Geometrische vormen omvatten basisvormen, symboolvormen, blokpijlen, stroomdiagrammen, 
toelichtingen en sterren.

Afbeelding 17 geeft een deel van de werkbalk Tekening weer met de pictogrammen waarnaar 
wordt verwezen in de volgende gedeelten. Klikken op de pijl naast het pictogram opent een 
zwevende werkbalk met de relevante gereedschappen.

Tip
Het gebruik van al deze gereedschappen is vergelijkbaar met die van het 
gereedschap Rechthoek, hoewel ze verschillende geometrische vormen 
produceren.

Afbeelding 17: Gedeelte van de werkbalk Tekening

Basisvormen

Het pictogram Basisvormen    maakt een scala van 
gereedschappen beschikbaar voor het tekenen van basisvormen, 
inclusief een gereedschap voor rechthoeken dat soortgelijk is aan 
dat op de hoofdwerkbalk.

Het enige verschil ziet u in het informatie-veld in de statusbalk (in dit 
geval 'Vorm geselecteerd' in plaats van 'Rechthoek geselecteerd').
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Symboolvormen

Het pictogram Symboolvormen   maakt een scala van 
gereedschappen beschikbaar voor het tekenen van verschillende 
symboolvormen.

Blokpijlen

Het pictogram Blokpijlen  opent de werkbalk Blokpijlen.

Stroomdiagrammen
De gereedschappen voor het tekenen van stroomdiagrammen 
worden geopend door te klikken op het pictogram 
Stroomdiagrammen .

Het maken van stroomdiagrammen, organogrammen en dergelijke 
wordt beschreven in hoofdstuk 9 Organogrammen, 
stroomdiagrammen en meer in de Handleiding voor Draw.

Toelichtingen

Gebruik het pictogram Toelichtingen  om de werkbalk 
Toelichtingen te openen. 

Sterren en banieren
Deze gereedschappen zijn verbonden met het pictogram 
Sterren .

U kunt tekst toevoegen aan al deze vormen. Zie hoofdstuk 2 Basisvormen tekenen en hoofdstuk 
10 Geavanceerde technieken voor Draw in de Handleiding voor Draw voor details.
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Objecten selecteren

Er zijn drie selectie-modi: verplaatsen en veranderen van grootte, bewerken en draaipunten.

Klik op de knop Punten op de werkbalk Tekening om de standaard modus in te stellen 
(verplaatsen en groottes wijzigen of bewerken) voor het selecteren van objecten. 

In de standaard modus (als u begint met een nieuwe tekening), is het 
pictogram Punten niet actief, de standaard is dan het verplaatsen of 
wijzigen van grootte van selecties; deze selecties worden aangegeven 
door kleine groene vierkantjes.

Wanneer het pictogram Punten actief is, is de standaard modus het 
bewerken van selecties; deze selecties worden aangegeven met blauwe 
vierkantjes. Sommige objecten hebben één of meer extra handgrepen, die 
groter zijn of een andere kleur hebben. Dit wordt meer in detail uitgelegd in 
hoofdstuk 3 van de Handleiding voor Draw.

Selecties voor het draaien van objecten worden aangegeven door kleine 
rode cirkeltjes en een symbool dat het centrum van de rotatie aangeeft. 
Klik op knop van de keuzelijst Effecten  op de werkbalk Tekening om 
deze selecties te kiezen.

Selectiemodi wijzigen
U kunt van de ene modus naar de andere modus gaan op één van de volgende manieren:

• Kies de knop Punten  op de werkbalk Tekening om te schakelen van de eenvoudige 
selectiemodus naar de modus Punten. U kunt ook gebruik maken van de sneltoets F8 
(Punten).

• Kies de knop van de keuzelijst Effecten  op de werkbalk Tekening om de modus 
Draaien voor een geselecteerd object te activeren.

• Als u vaak werkt in modus Draaien, kunt u kiezen voor de knop Draaimodus na het 

klikken op object  op de werkbalk Opties, waarmee u van de normale naar de modus 
Draaien gaat door gewoon op het object te klikken. Dit kan handiger zijn dan te klikken op 
het object en dan klikken op het pictogram Draaien op de werkbalk Tekening.

• Klik opnieuw op de knop Draaimodus na het klikken op object om te stoppen met 
werken in de modus Draaien.

Objecten selecteren 21



Objecten selecteren

Directe selectie
De eenvoudigste manier om een object te selecteren, is door er direct op te klikken. Voor objecten, 
die niet gevuld zijn, klikt u rechtstreeks op de omtrek van het object om het te selecteren.

Selectie door omkadering
U kunt met behulp van de muis meerdere objecten tegelijk selecteren 
door een grote rechthoek rond de objecten te slepen, zoals afgebeeld. 
Het pictogram Selecteren  op de werkbalk Tekening moet actief zijn 

om dit te laten werken. Alleen objecten die zich geheel binnen de 
rechthoek bevinden worden geselecteerd.

Selecteren van verborgen objecten
Zelfs wanneer objecten zich achter andere bevinden en niet zichtbaar zijn, kunnen ze nog worden 
geselecteerd. Houd de Alt-toets ingedrukt en klik waar het object zich bevindt. Houd de Alt-toets 
ingedrukt en klik door de objecten tot u object bereikt dat u zoekt, indien dat wordt bedekt door 
verscheidene overlappende objecten. Houd de Alt+Shift-toetsen ingedrukt om in omgekeerde 
volgorde door de objecten te gaan. Het aantal en type geselecteerde objecten wordt weergegeven 
aan de linkerzijde van de statusbalk om u te helpen  het juiste object te selecteren.

Opmerking

Deze methode werkt over het algemeen op Windows, maar op een Linuxsysteem 
doet het dat gewoonlijk niet. Als de Alt-toets op uw systeem niet werkt zoals 
hierboven beschreven, gebruik dan de methode met de Tab-toets zoals hieronder 
beschreven.

Druk op de Tab-toets om door de objecten te gaan en te stoppen op het object dat u wilt selecteren 
om een object te selecteren, met behulp van het toetsenbord, dat wordt verborgen door een ander 
object. Druk op Shift+Tab om in omgekeerde volgorde door de objecten te gaan. Dit is misschien 
niet praktisch als u een groot aantal objecten in uw tekening heeft.

Wanneer u klikt op het geselecteerde object, zal de omtrek kort 
verschijnen door de objecten die het bedekken.

In de afbeelding aan de rechterkant, werd het vierkant, gelegen onder 
de cirkel, op deze manier geselecteerd (de cirkel is transparant 
gemaakt om het vierkant te kunnen zien).

Objecten ordenen
In een complexe tekening kunnen verschillende objecten op elkaar gestapeld zijn. Selecteer het 
object, kies Wijzigen > Schikken en kies Naar voren of Naar achteren om de gestapelde 
volgorde opnieuw te schikken (een object verplaatsen van de voorzijde naar de achterzijde van de 
stapel). Of klik met rechts op het object, kies Schikken uit het contextmenu, en kies Naar voren of 

Naar achteren. Deze opties zijn ook beschikbaar op de werkbalk Schikken met de knop  van 
de werkbalk Tekening. Een sneltoetscombinatie is Shift+Ctrl+'plus'-teken om een object naar voren 
te verplaatsen en Shift+Ctrl+'min'-teken om een object naar achteren te verplaatsen.

Draw bevat ook gereedschappen om meerdere objecten uit te lijnen; details worden gegeven in de 
Handleiding voor Draw.
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Meerdere objecten selecteren
Druk op de Shift-toets en klik daarna op de verschillende objecten om een aantal objecten één 
voor één te selecteren of de selectie daarvan op te heffen. Eén klik op een object selecteert het, 
een tweede klik heft de selectie op.

Verplaatsen en dynamisch aanpassen van de grootte van een 
object

Er zijn verschillende manieren om een object te verplaatsen of de grootte ervan te veranderen. De 
hier beschreven dynamische methode gebruikt de muis.

Wanneer u dynamisch een object wijzigt of verplaatst, controleert u dan het linker gedeelte van de 
statusbalk van Draw. Dit gebied geeft gedetailleerde informatie over de uitgevoerde handeling. De 
informatie verandert wanneer de muis wordt verplaatst.

Dynamisch verplaatsen van objecten
Selecteer het object door binnen de randen van het object te klikken 
en houd de linker muisknop ingedrukt terwijl u de muis versleept om 
een object te verplaatsen.

Tijdens de verplaatsing verschijnt de vorm van het object als een 
vervaagde versie van de vorm om te helpen bij de verplaatsing.

Laat de muisknop los om het object op zijn nieuwe locatie te plaatsen. 
De nieuwe positie verschijnt onmiddellijk in de statusbalk.

Dynamisch de grootte van objecten aanpassen
Verplaats één van de handgrepen rondom de selectie om de grootte 
van een object (of een groep van geselecteerde objecten) met de muis 
te wijzigen. Zoals weergegeven in de volgende afbeelding wordt een 
vervaagde versie van de vorm van het nieuwe object weergegeven.

De resultaten zijn afhankelijk van welke handgreep u gebruikt. Gebruik de toepasselijke handgreep 
aan de zijkant om de grootte van een object langs één as te wijzigen. Gebruik een handgreep in de 
hoek om de grootte langs beide assen te wijzigen. De nieuwe grootte verschijnt onmiddellijk in de 
statusbalk.

Opmerking
Als u op de Shift-toets drukt bij het aanpassen van de grootte van een object, zal de 
verandering van de grootte symmetrisch worden uitgevoerd ten opzichte van de 
twee assen; zodat de verhoudingen (hoogte/lengte) van het object hetzelfde blijven.

Draaien
Draaien van het object verplaatst het object rondom een as. Gebruik de rode handgrepen, zoals u 
doet bij het veranderen van de grootte van een object, om dit dynamisch (met de muis) te doen.
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Opmerking

Het draaien werkt op een iets andere manier voor 3D-objecten omdat de draaiing 
plaatsvindt in een 3D-ruimte en niet in een vlak. Zie hoofdstuk 7 Werken met 3D-
objecten in de Handleiding voor Draw betreffende draaiing wanneer de modus 
Punten bewerken actief is.

Sleep met de muis aan de rode handgrepen in de hoek van de selectie om een object (of een 
groep van objecten) te draaien. De muiscursor neemt de vorm aan van een boog met een pijl aan 
elk uiteinde. Een vervaagde versie van het object, dat wordt gedraaid, verschijnt en de huidige 
hoek van draaiing wordt dynamisch weergegeven in de statusbalk.

Rotaties worden gemaakt om een as die wordt weergegeven als een klein symbool, zoals 
weergegeven in Afbeelding 18. U kunt de rotatieas met de muis verplaatsen.

Als u de Shift-toets ingedrukt houdt tijdens het draaien, zal het het draaien gebeuren in stappen 
van telkens 15°. 

Afbeelding 18: Draaien van een object

Schuintrekken en perspectief
Gebruik de rode handgrepen in het midden of aan de randen van de geselecteerde objecten om 
objecten schuin te trekken. De muisaanwijzer verandert in  wanneer u de muisaanwijzer 
beweegt boven één van deze handgrepen in het midden. Niet elk object kan worden schuin 
getrokken; basisvormen kunnen gedraaid, maar niet schuin getrokken worden.

De as voor het schuintrekken is het punt dat direct tegenover de 
handgreep in het midden ligt die wordt gebruikt voor het 
schuintrekken van het object. Dit punt blijft op dezelfde plaats, 
de zijden worden verplaatst in relatie tot het verslepen van de 
muis (zorg er voor dat het pictogram van de handgreep wordt 
weergegeven voor het slepen).

Net zoals bij het draaien, kunt u er voor zorgen dat het 
schuintrekken gebeurt in stappen van 15° door de Shift-toets 
ingedrukt te houden terwijl u de handgreep verplaatst.

Objecten bewerken

Om de attributen van een object (zoals kleur en dikte van de rand) te veranderen kunt u gebruik 
maken van de werkbalk Lijn en opvulstijl of het contextmenu.
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Als de werkbalk Lijn en opvulstijl (Afbeelding 21) niet zichtbaar is, kunt u deze weergeven met 
behulp van Beeld > Werkbalken > Lijn en opvulstijl. Van hier uit kunt u de meeste algemene 
attributen van objecten bewerken. U kunt ook het dialoogvenster Lijn openen door te klikken op 
het pictogram Lijn  en het dialoogvenster Gebied openen door te klikken op het pictogram Vlak

  om meer opties te zien.

1 Stijlen en opmaak

2  Lijn

3  Pijlen

4  Lijnstijl

5  Lijndikte

6  Lijnkleur

7      Vlak

8–9  Opvulstijl

10    Schaduw

Afbeelding 19: Werkbalk Lijn en opvulstijl

Wanneer u tekst selecteert, verandert deze werkbalk en toont de opties voor tekstopmaak.

Het contextmenu
Wanneer een object is geselecteerd, kunt u met de rechter muisknop op het object klikken om een 
contextmenu te openen, dat voorziet in extra toegang tot de hierboven getoonde opties en een 
andere manier om de attributen van een object te wijzigen. De vermeldingen met een kleine pijl 
aan de rechterkant bevatten een submenu.

Lijnen en randen bewerken
Lijnen, pijlen en de randen van een object worden beheerd via 
het dialoogvenster Lijn. Een rand van een object is gewoon een 
ander type lijn.

U kunt enkele eigenschappen van de werkbalk Lijn en opvulstijl wijzigen. Selecteer het object en 

klik op het pictogram Lijn  of klik met de rechter muisknop op het object en kies Lijn uit het 
contextmenu om meer opties te zien. Dit opent het dialoogvenster Lijn.

Algemene lijneigenschappen

In de meeste gevallen wilt u de stijl van de lijn (vast, stippellijnen, onzichtbaar, enzovoort), de kleur 
of de breedte wijzigen. Deze opties zijn beschikbaar vanaf de werkbalk Lijn en opvulstijl 
(Afbeelding 19).

U kunt deze eigenschappen ook bewerken met het dialoogvenster Lijn, hierin kunt u ook 
transparantie van de lijn wijzigen. Afbeelding 20 toont verschillende graden van transparantie.
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Afbeelding 20: De verticale lijnen hebben 
verschillende niveaus van transparantie 
(0%, 25% en 50%).

Pijlen tekenen
Pijlpunten (en andere lijnuiteinden – gewoonlijk collectief aangeduid als pijlen) zijn 
een eigenschap van een lijn. Selecteer een lijn en klik op het pictogram Pijlstijl 

op de werkbalk Lijn en opvulstijl. Dit opent het menu Pijlpunten.

Verschillende soorten pijlpunten zijn beschikbaar. Elk uiteinde van de lijn kan een 
andere pijlpunt hebben (of geen pijlpunt).

Pijlpunten kunt u alleen toepassen op lijnen. Ze hebben geen effect op randen van 
een object.

Lijn- en pijlstijlen aanpassen
U kunt de lijn- en pijlstijlen wijzigen en uw eigen maken. Zie hoofdstuk 4 Attributen 
van objecten wijzigen in de Handleiding voor Draw voor details.

Bewerken van de binnenkant (vulling) van een object
De term in LibreOffice voor de binnenzijde van een object is Vlakvulling. De vlakvulling van een 
object kan een uniforme kleur, een kleurovergang, een arcering of een afbeelding zijn. Het object 
kan geheel of gedeeltelijk transparant worden gemaakt en het kan een schaduw werpen.

In de meeste gevallen zult u kiezen uit één van de standaard opties, die allemaal beschikbaar zijn 
op de werkbalk Lijn en opvulstijl. U kunt ook uw eigen vlakvullingen definiëren, zie hoofdstuk 4 van 
de Handleiding voor Draw voor details.
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Een schaduw toevoegen
In Draw worden schaduwen beschouwd als een eigenschap van een 
gebied. Klik op het pictogram Schaduw  op de werkbalk Lijn en 
opvulstijl.

U kunt de positie, afstand, kleur en transparantie van de schaduwen 
aanpassen door middel van Opmaak > Vlak > Schaduw of door met 
rechts te klikken op het geselecteerde object en te kiezen Vlak > 
Schaduw.

Transparantie toevoegen
U kunt objecten gedeeltelijk of volledig transparant maken en zelfs de mate van transparantie 
(zoals een kleurovergang) wijzigen.

Opmaakprofielen gebruiken

Stel dat u dezelfde vlakvulling, lijndikte en randen op een verzameling objecten wilt toepassen. Dit 
herhalend proces kan sterk worden vereenvoudigd door het gebruik van opmaakprofielen. 
Opmaakprofielen maken het u mogelijk om een opmaaksjabloon (een groep opmaakprofielen) te 
maken en dat vervolgens toe te passen op meerdere objecten. Voor meer informatie over 
opmaakprofielen, zie hoofdstuk 3 Opmaakprofielen en sjablonen gebruiken.

Speciale effecten

Met Draw kunt u veel speciale effecten op objecten en groepen van objecten toepassen. Dit 
gedeelte beschrijft een aantal van deze effecten. Meer effecten, inclusief vervormen, schaduwen 
en transparantie, zijn te vinden in hoofdstuk 4 Attributen van objecten wijzigen van de Handleiding 
voor Draw.

Een object spiegelen

Selecteer een object en klik op het pictogram Spiegelen  in het menu 
Effecten. U zult een stippellijn door het midden van het object zien.

Deze stippellijn is de symmetrieas. Het object zal worden gespiegeld ten 
opzichte van deze lijn. Verplaats één of beide uiteinden van de lijn met uw 
muis om de as in te stellen.

Grijp één van de acht groene handgrepen vast en versleep deze naar de 
andere kant van de stippellijn. De nieuwe positie van de figuur wordt 
weergegeven met stippellijnen totdat de muis wordt losgelaten.

Opmerking
Als u de Shift-toets ingedrukt houdt terwijl u de lijn verplaatst, zal de lijn telkens met 
een hoek van 45 graden draaien.
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Een gespiegelde kopie maken
Verplaats de symmetrieas naar de gewenste locatie op de spiegelas. Kopieer het object naar het 
klembord. Spiegel het object, klik dan op een leeg gebied in het scherm van Draw om de selectie 
van het object op te heffen. Plak vanaf het klembord een kopie van het object op zijn 
oorspronkelijke positie en dan heeft u een gespiegelde kopie.

Vervormen van een afbeelding
Er zijn drie gereedschappen in het menu Effecten die het mogelijk maken de hoeken en randen 
van een object te verslepen om het beeld te vervormen.

Het gereedschap Vervormen vervormt een object in perspectief, de gereedschappen Op cirkel 
zetten (schuintrekken) en Op cirkel zetten (perspectivisch) creëren beide een pseudo 
driedimensionaal effect. Zie hoofdstuk 4 van de Handleiding voor Draw voor details.

Dynamische kleurovergangen
U kunt de transparantie van kleurovergangen op dezelfde wijze beheren als voor kleurovergangen. 
Beide soorten kleurovergangen kunnen samen worden gebruikt. Met een transparante 
kleurovergang verandert de richting en de mate van opvullen van een object van ondoorzichtig 
naar transparant (in een normale kleurovergang verandert de ene kleur naar de andere, maar de 
mate van transparantie blijft hetzelfde). Zie hoofdstuk 4 van de Handleiding voor Draw voor details.

Dupliceren
Dupliceren maakt kopieën van een object en past een aantal wijzigingen (zoals kleur of draaiing) 
toe op de duplicaten. Het resultaat van dupliceren is een nieuwe groep objecten.

Klik op een object (of op een groep geselecteerde objecten) en kies dan Bewerken > Dupliceren 
(shift+F3) om te beginnen met dupliceren. Het dialoogvenster wordt in Afbeelding 21 
weergegeven.

Als de in dat dialoogvenster gekozen opties worden toegepast op een groene rechthoek, geeft dat 
het volgende resultaat.
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Afbeelding 21: Dupliceren van een object

Vormovergang
Vormovergang transformeert een vorm van de ene vorm naar een andere. Het resultaat is een 
nieuwe groep van objecten, inclusief het begin- en eindpunt en de tussenliggende stappen.

Selecteer eerst twee objecten (houd de Shift-toets ingedrukt terwijl u elk object op zijn beurt 
selecteert) en kies dan Bewerken > Vormovergang om een vormovergang uit te voeren.

Kies het aantal stappen (overgangsstappen) in het dialoogvenster Vormovergang. U zult 
waarschijnlijk Attributen en Identieke afdrukstand beide geselecteerd willen hebben. Het 
eindresultaat wordt weergegeven in Fout: Bron van verwijzing niet gevonden.

Afbeelding 22: Instellingen voor vormovergang kiezen
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Afbeelding 23: Voorbeeld van vormovergang

Het combineren van meerdere objecten

Met behulp van Draw kunt u tekenobjecten op twee verschillende manieren met elkaar verbinden: 
groeperen en samenvoegen. Deze twee methodes maken het u mogelijk om meerdere objecten 
als één eenheid te behandelen, of om objecten samen te voegen tot een nieuwe vorm.

Groeperen is zoals het samenbrengen van objecten in een container. U kunt ze als een groep 
verplaatsen en algemene wijzigingen aanbrengen. Een groep kan altijd ongedaan worden gemaakt 
en de objecten, die de groep vormen, kunnen altijd afzonderlijk worden gemanipuleerd.

Een samenvoeging is een permanente fusie van objecten die leidt tot een nieuw object. De 
oorspronkelijke voorwerpen zijn niet meer beschikbaar als individuele entiteiten en de actie is niet 
ongedaan te maken.

Groeperen door gemeenschappelijke selectie
Wanneer meerdere objecten zijn geselecteerd, worden de handelingen, die u verricht, toegepast 
op alle objecten. U kunt bijvoorbeeld een groep van objecten in zijn geheel draaien. Groepen, 
verkregen door middel van gemeenschappelijke selectie van meerdere objecten, worden 
ongedaan gemaakt zodra u buiten de groep klikt. U kunt echter objecten groeperen en deze 
geselecteerde objecten gegroepeerd houden.

Handhaven van groepen en het ongedaan maken van groepen
Selecteer eerst de objecten en klik dan met de rechter muisknop en kies Groeperen in het 
contextmenu om objecten te groeperen. U kunt ook de sneltoetscombinatie Ctrl+Shift+G gebruiken 
of Wijzigen > Groeperen kiezen in de menubalk.

Wanneer objecten zijn gegroepeerd, wordt elke bewerking toegepast op alle leden van de groep. 
Als u klikt op een lid van de groep, wordt de hele groep geselecteerd.

De objecten van een groep behouden hun eigen individuele eigenschappen. Klik met de rechter 
muisknop en kies Groepering opheffen in het contextmenu, gebruik de toetsencombinatie 
Ctrl+Alt+Shift+G of kies Wijzigen > Groepering opheffen op de menubalk om het groeperen 
ongedaan te maken.

U kunt een lid van een groep afzonderlijk bewerken zonder verbreking van de groep. Klik met de 
rechter muisknop en kies Groepering betreden of dubbelklik op de groep, om dit te doen.

Het samenvoegen van objecten
In tegenstelling tot de functies voor groepering, maakt Samenvoegen een nieuw object; 
aansluitend samenvoegen opheffen zoals Groeperen opheffen is niet mogelijk. Selecteer een 
verzameling objecten, klik met de rechtermuisknop en kies Samenvoegen in het contextmenu. 
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Nadat u meer dan een object heeft geselecteerd, worden de functies Samenvoegen, Aftrekken, 
Afknippen actief en kunnen worden bereikt via het menu Wijzigen > Vormen of in het 
contextmenu van de groep onder de kop Vormen.

Hulp bij het positioneren van objecten

Draw heeft verschillende gereedschappen om u te helpen bij het schikken van objecten ten 
opzichte van elkaar:

• Verplaatsen van een object naar voren of naar achteren

• Het uitlijnen van objecten ten opzichte van andere

• De afstand en de ruimte tussen objecten verdelen

Zie hoofdstuk 5 Het samenvoegen van meerdere objecten in de Handleiding voor Draw voor meer 
informatie.

Invoegen en bewerken van foto's

Draw bevat een aantal functies voor het bewerken van rasterafbeeldingen (bitmaps) – bijvoorbeeld 
foto's, gescande afbeeldingen – met inbegrip van importeren en exporteren alsmede omzetting 
van het ene formaat naar het andere. Draw kan bestanden lezen in alle gebruikelijke grafische 
bestandsindelingen.

U kunt foto's uit verschillende bronnen invoegen:

• De Galerij - zie hoofdstuk 11 Afbeeldingen, de Galerij en Fontwork

• Rechtstreeks vanaf een scanner (Invoegen > Afbeelding > Scannen) 

• Foto's gemaakt door een ander programma, inclusief foto's van een digitale camera 
(Invoegen > Afbeelding > Uit bestand) 

Draw biedt gereedschappen voor het werken met bitmap-afbeeldingen zoals foto's: de werkbalk 
Afbeelding en het palet beheren van bitmap-afbeeldingen. Maar het heeft echter niet dezelfde 
capaciteiten als de gespecialiseerde grafische programma's voor rasters zoals Adobe Photoshop 
of The Gimp. Zie hoofdstuk 6 Bewerken van foto's in de Handleiding voor Draw voor details en 
voorbeelden.

Werken met 3D-objecten

Hoewel Draw niet dezelfde functionaliteiten heeft als de toonaangevende teken- of 
fotobewerkingsprogramma's, is het in staat om zeer goede 3D-tekeningen te produceren en te 
bewerken.

Draw biedt twee soorten 3D-objecten aan: 3D-lichamen, en 3D-vormen. Afhankelijk van welk type 
u kiest, zijn er verschillende mogelijkheden voor verdere bewerking van het object (rotatie, 
belichting, perspectief). 3D-vormen zijn eenvoudiger in te stellen en te bewerken, maar 3D-
lichamen kunnen meer aangepast worden.

Zie hoofdstuk 7 Werken met 3D-objecten in de Handleiding voor Draw voor details.
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Afbeeldingen exporteren

Gebruik Bestand > Exporteren om een afbeelding van Draw in een andere indeling op te slaan 
dan *.odg. Draw kan bestanden in veel verschillende grafische bestandsformaten opslaan, zoals 
vermeld in Appendix B Achtergrondinformatie van dit boek. U kunt het gehele bestand of 
geselecteerde objecten exporteren.

U kunt Drawbestanden ook exporteren naar HTML, PDF of Flash. PDF-export is hetzelfde als voor 
andere delen in LibreOffice, zoals beschreven in Hoofdstuk 10 Afdrukken, e-mailen en exporteren 
van dit boek. Exporteren naar Flash maakt een .swf-bestand.

HTML-export maakt gebruik van een conversie assistent die evenveel webpagina's maakt als er 
pagina's in uw Draw document zijn. U kunt er desgewenst voor kiezen om de pagina's weer te 
geven in frames met een navigator en een index pagina aan te maken. Voor meer informatie, zie 
hoofdstuk 12, Webpagina's maken: Documenten opslaan als HTML-bestanden, van dit boek. 

Notities aan een tekening toevoegen

Draw ondersteunt notities op dezelfde wijze als die in Writer en Calc.

Kies Invoegen > Notitie uit de menubalk. Een klein vak, met daarin uw initialen, verschijnt in de 
linker bovenhoek van de pagina van Draw, met een groter vak ernaast. Draw heeft automatisch uw 
naam en de datum aan de onderzijde van dit tekstvak toegevoegd.

Typ of plak uw notitie in het tekstvak. Optioneel kunt u enige basale opmaak toepassen op de 
delen van de tekst door dat te selecteren, met rechts te klikken en te kiezen uit het contextmenu. 
Vanuit dit menu kunt u de huidige notitie, alle notities van dezelfde auteur, of alle notities in het 
document verwijderen.

U kunt de kleine markeringen van de notitie op de pagina verplaatsen naar waar u dat wilt. 
Gewoonlijk zou u het plaatsen op of nabij een object waarnaar u verwijst in de notitie.

Kies Beeld > Notities om de markeringen van de notities weer te geven of te verbergen.

Kies Extra > Opties > Gebruikersgegevens om de naam in te voeren die u wilt laten verschijnen 
in het veld Auteur van de notitie.

Als meer dan één persoon het document bewerkt, krijgt elke auteur automatisch een andere 
achtergrondkleur toegewezen.
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